
Experiment IXECG12: 12-Lead Electrocardiograms (ECGs)

Equipment Required

PC or Mac Computer

IX-ECG-12 

Electrode lead wires

Alcohol swabs

Disposable ECG electrodes (12)

Optional - A-ECG-SIM-1200 – ECG simulator

Start the Software - NOTE: Make sure to load the Research Settings 

1. Click on LabScribe 

2. Click Settings → IX-ECG12→ IXECG12-12LeadECG

3. The necessary document will open automatically.

Background

Discrete areas of electrical activity in the heart can be defined by an electrocardiogram recorded 

simultaneously from different points of view around the heart. Each point of view is commonly called a

lead. The multiple lead electrocardiogram that is most universally accepted as a clinical tool is known 

as the 12-Lead ECG. This electrocardiogram uses one electrode on each limb of the subject, and an 

electrode on each of six different positions on the chest. Many 12-Lead ECG monitors have inputs and 

wiring for each of the six chest electrodes. However, if the monitor has only one input and cable for 

recording from the chest, the cable must be moved from one chest electrode to another in order to 

complete the recording from all six positions on the chest. 

Unipolar and Bipolar Leads

To record an electrocardiogram from twelve different points of view, the outputs of limb and chest 

electrodes need to be combined in nine of the twelve leads. On many ECG monitors, the combinations 

are created by rotating a simple switch called the ECG lead selector. 

Each of the standard limb leads (Leads I, II, and III) record electrocardiograms between two of the 

three limb electrodes. These leads are classified as bipolar leads because two electrodes are involved in 

the recording. The voltage at the active (recording) electrode is referenced against the voltage at the 

indifferent electrode. For example, the voltage at the electrode on the left leg is compared to the voltage

on the right arm or shoulder in Lead II recordings. 

Each of the augmented limb leads (aVR, aVL, aVF) record electrocardiograms between an active limb 

electrode and an indifferent point which is formed by the joining of the two remaining limb electrodes 
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through the ECG lead selector. The augmented leads are classified as unipolar because the voltage at 

the active electrode is referenced against a point that is equidistant between the two non-active 

electrodes.

The chest leads, known as V1 through V6, record electrocardiograms between an active chest electrode

and another indifferent point formed by the joining of the limb electrodes through the ECG lead 

selector. The chest leads are also unipolar because the voltage at the active electrode on the chest is 

referenced against an indifferent point in the center of a triangle formed by the limb leads.

Plane of the Limb Leads

In the standard 12-Lead ECG, the six limb leads look at the heart along six directions in a vertical plane

that is best described as being parallel to the floor when the subject is reclining. The information from 

these leads can determine the electrical axis of the atria and ventricles during depolarization (Figure 

HH-13-1). A variation in the angle of this electrical axis can be caused by a variety of physiological or 

pathological conditions. For example, right-axis shifts are common in extremely thin and healthy 

persons; the causes of the shifts in these cases are physiological. Right-axis shifts also appear in 

persons with right bundle branch blocks or right ventricular hypertrophy; however, in these cases, the 

deviations are caused by pathological problems. All of the deviations detected by the limb leads are 

around a horizontal axis that is perpendicular to the vertical plane of these leads.

Plane of the Chest Leads

The six chest leads of the 12-Lead ECG are often called the precordial leads. The chest leads are in an 

almost horizontal plane that is best described as being parallel to the floor when the subject is standing. 

The electrocardiograms from these leads can be used for diagnosing damage to cardiac tissue caused by

coronary occlusions or ventricular hypertrophy. These types of determinations are possible because 

chest leads are unipolar and placed in an array. The active electrodes in these leads respond to electrical

activity directly beneath them whether the activity is moving towards or away from the electrode, or 

from side to side. The depolarizations that move toward an electrode appear as positive deflections; if 

the depolarizations are moving away from the electrode, the deflection is negative.

Figure HH-13-1: Einthoven’s Triangle identifying the axes of the six limb leads.
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Recordings from a normal, healthy heart usually show a large S wave from the V1 and V2 leads. The 

V3 and V4 leads provide QRS complexes that are biphasic, R and S waves of equal magnitude in 

opposite directions. The lead with a biphasic QRS complex overlies the anterior edge of the 

interventricular septum, also known as the transition point. A shift in the transition point results from an

abnormal orientation of the heart around a vertical axis that is perpendicular to the horizontal plane of 

the chest leads.

In this lab, you will record electrocardiograms from Lead I, Lead II, and one of the six chest leads 

(Figure HH-13-2). Lead I will be used as a reference. The augmented limb leads; Lead III, aVR, aVL, 

and aVF, will be calculated from the reference electrode. The chest lead will be moved to the correct 

locations on the subjects chest to record each of 6 chest lead positions. The amplitudes and shapes from

each chest lead will be compared, and the transition point of each subject will be determined. 

Figure HH-13-2: Electrocardiograms recorded from Lead I, Lead II, and Lead V1 positions at the 

same time. The other leads have been minimized.

Note: It is suggested that students dress appropriately for these exercises. A button-down shirt will 

make it easier to position the chest leads.
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Electrode Placement

1. The subject should remove all jewelry from his or her neck, wrists, and ankles. Cell phones 

should be removed from pockets.

2. Use an alcohol swab to clean and scrub regions on each wrist and ankle, under the lateral end of

each clavicle and, on the chest (Figure HH-13-3). Let the areas dry.

3. Obtain 12 disposable electrodes. Remove each electrode from its protective plastic sheet and 

apply it to one of the following scrubbed areas on the subject’s body:

• under the lateral ends of each clavicle; for use as the positive and negative electrodes of 

Lead I.

• on each wrist and each ankle; for use as the ground and the three electrodes that form the

indifferent point for the chest leads.

• over the right border of the sternum at the 4th intercostal space; for use as the active 

electrode of the V1 chest lead.

• over the left border of the sternum at the 4th intercostal space; for use as the active 

electrode of the V2 chest lead.

• on the left mid-clavicular line at the 5th intercostal space; for use as the active electrode 

of the V4 chest lead.

• halfway between V2 and V4; for use as the active electrode of the V3 chest lead.

• on the anterior axillary line at the same horizontal level as V4; for use as the active 

electrode of the V5 chest lead.

• on the mid-axillary line at the 5th intercostal space; for use as the active electrode of the 

V6 chest lead.

ECG Cable Setup

1. Locate the IXECG12 unit (Figure HH-13-4). Insert the USB connector into a USB port on the 

computer.  

2. Snap the other ends of the lead cables to the electrodes on the subject, so that:

• the white snap lead wire is connected to the electrode below the right clavicle,

• the black snap lead wire is connected to the electrode below the left clavicle,

• the green snap lead wire is connected to the electrode on the right ankle,

• the red snap lead wire is connected to the electrode on the left leg.

3. Attach the six color-coded snap chest leads (red, yellow, green, blue, orange, purple) to the 

electrodes on the subject, so that: 

• the red “V1” lead wire connects to the electrode at the fourth intercostal space (between 

ribs 4 & 5) just to the right of the sternum (breastbone).

• the yellow “V2” lead wire connects to the electrode at the fourth intercostal space 

(between ribs 4 & 5) just to the left of the sternum.
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• the green “V3” lead wire connects to the electrode between leads “V2” and “V4”.

• the blue “V4” lead wire connects to the electrode at the fifth intercostal space (between 

ribs 5 & 6) in the mid-clavicular line (the imaginary line that extends down from the 

midpoint of the clavicle (collarbone).

• the orange “V5” lead wire connects to the electrode horizontally even with V4, but in 

the anterior axillary line. The anterior axillary line is the imaginary line that runs down 

from the point midway between the middle of the clavicle and the lateral end of the 

clavicle; the lateral end of the collarbone is the end closer to the arm.

• the purple “V6” lead wire connects to the electrode horizontally even with V4 and V5 in

the mid-axillary line. The midaxillary line is the imaginary line that extends down from 

the middle of the patient's armpit.

Figure HH-13-3: A: Frontal view of the electrode positions for Lead I and the six chest leads. B: Top 

view of the electrode positions for the chest leads.
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Figure HH-13-4: The IX-ECG12.

Procedures:

Exercise 1: ECG from the Chest Leads of a Resting Subject

Aim: To record Resting electrocardiograms from the six chest leads and determine the transition point.

Approximate Time: 15 minutes

Procedure

1. The recording of electrocardiograms from Leads I, II, Leads III, aVR, aVL, aVF, and the six 

chest leads (V1 through V6) will use the LabScribe2 software. 

2. Make sure the lead wires are attached correctly for recording from Lead I, Lead II, and the other

6 “V” Leads.

3. Type “Resting” in the Mark box to the right of the Mark button. 

4. After the subject has been sitting quietly for at least one minute, click the Record button on the 

LabScribe Main window. Immediately after starting to record, press mark button to mark the 

recording for a resting ECG of the 8 live leads and 4 calculated leads. 

5. Record for at least 5 minutes to get a good stable recording of the resting ECG. Click the 

AutoScale All button to display the electrocardiogram data in a suitable manner (Figure HH-13-

5).

6. Select Save As in the File menu, type a name for the file. Click on the Save button to save the 

data file.
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Figure HH-13-5: The recording of a 12-lead electrocardiogram as shown in the Main window of 

LabScribe2. Note heart rate shown on the bottom channel.

Data Analysis

1. Click the 2-Cursor icon (Figure HH-13-6) so that two vertical lines appear over the recording 

window.

2. Scroll through the this section of data and find an area with at least five or six exemplary 

ECG/pulse cycles in succession.

3. Use the Display Time icons to adjust the Display Time of the Main window to show at least five

complete ECG/Pulse cycles on the Main window. Five adjacent ECG/Pulse cycles can also be 

selected by:

• Placing the cursors on either side of a group of four complete ECG/Pulse cycles.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

segment with the five selected ECG/Pulse cycles to the width of the Main window.

5. Data can be collected from the Main window or the Analysis window.  If you choose to use the 

Analysis window, click on the Analysis window icon in the toolbar.

6. The mathematical functions, V2-V1, T2-T1 and Mean should appear on screen. The values for 

V2-V1, T2-T1 and Mean on each channel are seen in the table across the top margin of each 

channel, or to the right of each graph (Figure HH-13-7).
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Figure HH-13-6: The LabScribe2 toolbar.   

7. Once the cursors are placed in the correct positions for determining the amplitudes, V2-V1, the 

values of the amplitudes can be recorded in the on-line notebook of LabScribe by typing their 

names and values directly into the Journal, or on a separate data table.

8. The functions in the channel pull-down menus of the Analysis window can also be used to enter

the names and values of the parameters from the recording to the Journal. To use these 

functions:

• Place the cursors at the locations used to measure the amplitudes of the waves in the 

ECG cycle.

• Transfer the name of the mathematical functions used to determine the amplitudes to the 

Journal using the Add Title to Journal function in the Tools pull-down menu.

• Transfer the values for the amplitudes to the Journal using the Add Ch. Data to Journal 

function in the Tools pull-down menu.

• To transfer the image to the Journal, use the Add Image to Journal function in the Tools 

pull-down menu.

9. Use the mouse to click and drag the cursors across the section of data for Resting ECG to 

measure:

• the amplitude, V2-V1, of five adjacent R waves in the ECG from Lead I, Lead II and the

V1-V6 chest leads. The amplitude is measured from the onset of the Q wave to the peak 

of R wave.  Data from Lead III, aVR, aVL and aVF may also be collected.

• the amplitude, V2-V1, of five adjacent P waves in the ECG from the same section of 

data. The amplitude is measured from the baseline, between the T and P waves, to the 

peak of P wave. Data from Lead III, aVR, aVL and aVF may also be collected.

• the amplitude, V2-V1, of five adjacent T waves in the ECG from the same section of 

data. The amplitude is measured from the baseline to the peak of T wave. Data from 

Lead III, aVR, aVL and aVF may also be collected.
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Figure HH-13-7: In the Analysis window, the electrocardiogram showing the cursors in position to 

measure the amplitude (V2-V1) of a T-wave. Note: some chest leads not shown.

10. Click the Main Window icon from the LabScribe toolbar to go back to the main recording 

window.

11. Calculate the average amplitudes of the P, R, and T waves for each lead. Enter these values into 

the table (Table HH-13-1).

12. Find the transition point of the subject by examining the recordings from the six chest leads. 

Find the lead where the R wave is equal in magnitude to the S wave but in the opposite 

direction.

Questions

1. From which leads are inverted P and T waves recorded? From which leads are inverted R waves

recorded?

2. From which lead is the amplitude of the R wave equal, and opposite in direction, to the S wave?

3. Which lead is over the anterior edge of the interventricular septum?
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Table HH-13-1:The average amplitudes (in millivolts) for each of the waves recorded from each 

lead.

Average Amplitudes P Wave R Wave T Wave

Lead I

Lead II

V1

V2

V3

V4

V5

V6

Lead III

aVR

aVL

aVF

Exercise 2: ECG from the Chest Leads of Other Students 

Aim: To record electrocardiograms from the six chest leads of other subjects and determine their 

transition points.

Approximate Time: 15 minutes per subject

Procedure

1. Disconnect the leads from the first volunteer’s electrodes and place them on the electrodes of a 

second student. 

2. Follow the procedures in Exercise 1 to record electrocardiograms from the six chest leads of the

new subject.

3. Repeat the procedures until all subjects have recorded their chest lead electrocardiograms.

Data Analysis

Make the same measurements as done in Exercise 1.
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Questions

1. Do the R waves, from the same lead position, go in the same direction for all subjects? The P 

waves? The T waves? 

2. What would cause the same type of wave from the same lead to go in the opposite direction in 

different subjects?

3. Do all subjects have the same transition point? Which leads were found to be the transition 

points in the subjects tested? What could cause a difference in the transition points?

Exercise 3: ECG Hypothesis, Data Collection and Analysis

Aim: To have students design their own experiment based on their knowledge of what may alter a 

person’s ECG. 

Approximate Time: 20 minutes or more based on the group’s hypothesis

Procedure

1. Formulate a hypothesis where you would expect to see changes in the subject’s ECG.

2. Make sure to present this hypothesis to your instructor and get permission to do the experiment 

prior to continuing with your experiment.

3. Follow the procedures in Exercise 1 to record an ECG from your subject and collect data during

the testing of your hypothesis.  Timing changes will be the most significant observations.

Data Analysis

1. Make the same measurements as done in Exercise 1.

2. Create a data table in which to record your data.

3. Compare your data to the data recorded in Exercise 1.

Questions

1. What happened to the subject’s ECG during the testing of your hypothesis? 

2. What parameters changed? How did they change?

3. Did your hypothesis get the expected results? Why or why not?
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Exercise 4: Using the 12-Lead ECG Simulator

Aim: To record simulated electrocardiograms showing a variety of abnormal rhythms and to be able to 

understand the differences between these and normal sinus rhythm.

Approximate Time: 10 minutes per rhythm

ECG Cable Setup

1. Plug the snap leads from the IXECG12 to the appropriate snaps on the ECG-SIM-1200 - ECG 

Simulator.

• The four limb leads will be connected on the right side of the simulator - RA, RL, LA 

and LL.

• The six chest leads will be connected to the left side of the simulator - V1, V2, V3, V4, 

V5, and V6.

2. Make sure the snaps are securely fastened to the simulator.

Procedure

1. Retrieve the ECG-SIM-1200-12Lead ECG Simulator (Figure HH-13-8) and check to make sure

the batteries have been installed properly.

2. Turn the unit on by pressing the On/Off button on the front of the unit. The light will glow on 

one of the selected rhythms.

3. Press NSR to select normal sinus rhythm.

4. Press the Record button to start the recording of normal sinus rhythm. Record for a minimum of

30 seconds to get a good recording of a normal cardiac rhythm.

5. Press Stop to halt the recording. Press Save to save your data.

Figure HH-13-8: ECG-SIM-1200
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6. Choose another rhythm to record by pressing the button associated with the cardiac rhythm you 

wish to examine.

• As examples:

• Select 1st RBBB for 1st right bundle branch block

• Select AFIB for atrial fibrillation

• Select S Tach Ant ST+ for sinus tachycardia 

Note: Any rhythm can be selected by pressing the button associated with the cardiac rhythm you wish 

to view.

7. Repeat steps 4-6 to continue recording a variety of cardiac rhythms. It is suggested that at least 

5 different rhythms are recorded to gain an understanding of the variety of cardiac arrhythmias 

that may present themselves in a clinical situations.

Data Analysis

1. Make the same measurements as done in Exercise 1 with the addition of measuring the duration

of each wave form.

2. In the Analysis window, click add function to add the General T2-T1 function for determining 

the duration of each wave.

• Place the cursors on either side of the P-wave to find the Pwave duration.

• Place one cursor on the Q-wave and the second cursor on the S-wave to determine the 

duration of the QRS complex.

• Place the cursors on either side of the T-wave to find the Twave duration.

3. Create a data table in which to record your data.

4. Compare your data to the data recorded in Exercise 1 or to the normal sinus rhythm recorded 

using the ECG-SIM-1200 simulator (Figure HH-13-9).
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Figure HH-13-9:  Normal Sinus Rhythm recorded using the ECG simulator.

Questions

1. Based on normal sinus rhythm - compare the 5 different arrhythmias recorded.

• compare the P-wave amplitude and duration and discuss how and why the values are 

different from a ‘normal’ P-wave.

• compare the T-wave amplitude and duration and discuss how and why the values are 

different from a ‘normal’ T-wave.

• compare the QRS duration and discuss any differences.

2. Note any physiological factors that may cause the arrhythmias that you looked at.

3. Discuss the medical interventions that are available to correct the arrhythmias. Include both 

medical and surgical options.
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